
Teradici Software Development Kit for
Windows

The PCoIP Client Software Development Kit (SDK) for Windows is a set of

libraries and binaries that allow developers to build custom PCoIP clients. The

SDK is provided as part of Teradici Cloud Access Software and the resulting

client can connect to Cloud Access Software Standard Edition and Graphics

Edition through the Cloud Access and Cloud Access Plus plans. The SDK

includes the following components:

• Code Examples

• Programming Guide

• Session Client Source Code

• Session Client Binary Executable

• Session Client Libraries and API Headers

• Session Client API Documentation

• Broker Client Example Code

• Broker Client Libraries and API Headers

• PCoIP Core Libraries and API Headers

• PCoIP Core Binary

Supported Platforms

The PCoIP Client SDK can be used on the following Windows operating systems:

• Windows 10 (64-bit)

• Windows 7



What Can You Build With the PCoIP Client SDK?

The PCoIP Client SDK provides developers the ability to embed a PCoIP session

into any program or solution, or create a standalone client with a completely

custom user interface and workflow. With complete control over how a PCoIP

client is built, you can create clients that incorporate customizations in both pre-

session and in-session phases of a PCoIP connection. For example, the

following customizations are all typical use cases:

Pre-Session Customizations

• Customizing the client user interface to create a branded, end-to-end

solution using company assets such as:

• Corporate Logos

• Slogans, trademarks or other text

• Corporate colors and iconography

• Developing customized authentication workflows, either directly or using a

broker.

• Automatically connecting users to specific desktops or applications, based

on an identified user type or task.

• Embedding a remote workload into an application.

In-Session Customizations

• Client branding, including:

• Menu item labels

• Window titles

• Application icons

• Company logos

• Automatic bridging of USB devices.

• In-session menu bar visibility.

• Disabling hot keys.

• Client display size in windowed and fullscreen mode.



• Configuring resolutions.

• Securely using local and bridged USB devices.

Complete control of the in-session user experience is possible using the PCoIP

Core API.



Who Should Read This Guide?

This guide provides information for software developers and systems integrators

with an understanding of SDK integrations and virtualization systems who are

developing customized PCoIP clients. Readers should already understand the

Teradici Cloud Access Software and how it is used in virtual environments, in

both brokered and nonbrokered sessions. This guide will break down how to use

the session client executable and how to use the broker client API, session client

API and core API. This document is not intended for users who are unfamiliar

with SDK integrations, or for Teradici Cloud Access Software users who do not

require a customized PCoIP client. In this guide, you will learn about:

• PCoIP Session Components and Considerations

• Customizing the PCoIP Session

• Setting up a PCoIP Agent Test Environment

• Setting up a Development Environment for Windows

• Troubleshooting Issues related to Setting up, Developing and Building the

SDK

Understanding terms and conventions in Teradici guides

For more information on the industry specific terms, abbreviations, text conventions, and

graphic symbols used in this guide, see Using Teradici Product and Component Guides and the 

Teradici Glossary.



http://www.teradici.com/web-help/product_education/conventions/
https://www.teradici.com/web-help/Glossary/default.htm


What's New in This Release?

This release introduces the following features and enhancements to the PCoIP

Client Software SDK for Windows:

Core API

This release includes the PCoIP Core API and libraries. You can use these API's

to build a PCoIP Client from scratch. This new feature will enable developers to

have a deeper level of control.

Example Application

This release includes an example application (broker_client_example) to

showcase connecting to a third-party broker and launches the session client

(client_session.exe) along with it's source code.

Pre-built client_session.exe

This release includes a pre-built client_session.exe file which can be used for

launching the in-session. This can be used for building a custom client that just

requires customization around brokering.

CMake Modules

This release includes CMake modules for importing and linking the supporting

libraries in order to streamline the build process.



Enhanced Security and Stability

This release contains improvements and enhancements around the security and

stability of the SDK for Windows.



System Requirements

The following table outlines the system requirements for the PCoIP Client SDK

for Windows:

 

System Version Required

PCoIP Client SDK Operating Systems
• Windows 10 (64-bit)

• Windows 7 (64-bit)

Compatible PCoIP agents All PCoIP agents and versions

Compatible Teradici Remote Workstation Cards TERA22x0 with firmware 5.0.1+

Compatible PCoIP Host Software
• Host Software for Windows: 4.3.1+

• Host Software for Linux: 4.7.0+

Remote Workstation Platforms

PCoIP Host Software must be installed on Remote Workstation machines to enable keyboard

and mouse functionality.



Windows Embedded Standard systems are not supported

PCoIP Software Clients do not work on Windows Embedded Standard 7 or Windows Embedded

Standard 8.





Wacom Tablet Support

The Software Client for Windows supports Wacom tablets in two configurations: 

bridged, where peripheral data is sent to the desktop for processing, and locally

terminated, where peripheral data is processed locally at the Software Client.

Locally terminated Wacom tablets are much more responsive and tolerate low

latency connections.

Bridged Wacom Tablets

Bridged Wacom tablets are supported only in low-latency environments. Tablets

in network environments with greater than 25ms latency will show reduced

responsiveness and are not recommended.

The following Wacom tablet models have been tested and are supported on a

PCoIP Software Client for Windows.

PCoIP client support for bridged Wacom tablets and the Software Client for

Windows

 

PTK-440 PTH-451 PTH-660 Cintiq

22HD

PCoIP Standard Agent for Linux  — — —

PCoIP Graphics Agent for Linux  — — —

PCoIP Standard Agent for

Windows

 — — —

PCoIP Graphics Agent for

Windows

 — — —

PCoIP Remote Workstation Card — — — —



Other Wacom tablets may work, but have not been tested.

Locally Terminated Wacom Tablets

Locally-terminated tablets have greatly improved responsiveness, and tolerate

higher-latency (including 25ms and higher) networks.

Local termination requires:

• A Standard Agent for Windows version 2.15 or higher.

The following Wacom tablet models have been tested and are supported with

local termination.

PCoIP client support for locally terminated Wacom tablets and the Software

Client for Windows

 

PTK-440 PTH-451 PTH-660 PTH-860 Cintiq

22HD

PCoIP Standard Agent

for Linux

— —   —

PCoIP Graphics Agent

for Linux

— —   —

PCoIP Standard Agent

for Windows

— —   —

PCoIP Graphics Agent

for Windows

— —   —

PCoIP Remote

Workstation Card

— — — — —



About PCoIP Sessions

Establishing a PCoIP session involves a number of key components, including

system actors, PCoIP session phases, and connection brokers as discussed

next.

System Actors

There are at least three components that work together to create a PCoIP

session:

• PCoIP Client The hardware or software device, local to the user, which

requests and drives the PCoIP session by negotiating with PCoIP brokers

and PCoIP agents.

• PCoIP Broker Brokers maintain lists of active users, their authentication

information, and the host machines they can connect to. Except for systems

using direct connections, all PCoIP sessions are negotiated via third-party

brokers.

• PCoIP Agent The Teradici extension installed on the host machine. The

PCoIP agent is the single point of access for PCoIP clients, and handles all

video, audio, and USB exchanges between the client and desktop.

The following diagrams show the actors outlined above in a brokered and direct

connection:

Terminology: Hosts and Desktops

Host refers to a Windows, or Linux machine, either virual or physical, which has a PCoIP agent

installed and can serve a remote desktop to a PCoIP Client. Desktop refers to an entity which is

delivered to the client as a remote workload. This is typically a full Windows or Linux desktop,

but it can also be configured to present a single application.





Direct Connection 

Brokered Connection 



Session Client Integration

There are two methods of integrating the in-session phase, integrating using the

session client binary or using the session client API. The following diagrams

show these methods in relation to integrating the SDK into a custom application:

Session Client Binary Integration

This method uses the session client binary as a separate in-session application.

This is the simplest way to use the client SDK and it is recommended as the

initial mode to use for developing your own client. In this mode the pre-session

and session phases are handled by separate executables:

• Write a custom pre-session executable according to your workflow and

needs using the  source code as a starting point.

For more information see Session Client API Integration.

• Use the stock  executable, which is located within the

SDK at bin/client_session.exe, to establish the connection.

broker_client_example

client_session.exe

Security Considerations

The values passed to the client_session.exe executable include sensitive information required

to establish a session with the host. In particular, the connection tag is a single-use time-limited

(60 seconds) token that allows the client_session.exe executable to connect to the host as an

authenticated user. If an attacker is able to gain visibility to command line parameters as they

are passed to client session, it is possible that could use them before client_session.exe does

and gain access to the host as that user. It is vital to ensure good security practices are applied

to the client machine to prevent it from being compromised. This type of attack can be avoided

completely by integrating the pre-session and client_session.exe into a single executable as

described in the following section.





Binary Integration 

Session Client API Integration

This method uses the session client API to integrate the in-session functionality

into a custom application. This method is necessary if you wish to modify the

behavior of the client_session.exe executable beyond that which is possible via

its command line interface, or if you need to integrate the pre-session and

client_session.exe into a single executable. In this mode you will use:

• The broker_client_example source code as a starting point for writing

custom pre-session functionality

• The client_session.exe source code as a starting point for integrating with

the Session Client API.

The Session Client API provides a simple high level C++ interface for configuring,

starting, and stopping a session using the values obtained from a broker.



Session Client API Integration 

*Partner Virtual Channel Plugins can be developed using the Virtual Channel

SDK, to enable this you can combine the PCoIP Client SDK with the PCoIP Virtual

Channel SDK.

https://docs.teradici.com/find/product/cloud-access-software/2019.05/vchan-sdk/1.1.0?subscriptionName=cloud-access
https://docs.teradici.com/find/product/cloud-access-software/2019.05/vchan-sdk/1.1.0?subscriptionName=cloud-access


PCoIP Core Library Integration

The core library allows an application developer to integrate a PCoIP session

directly into an application. The core library facilitates connection to a remote

host, decoding PCoIP image data directly into an application supplied frame

buffer as well as remoting audio, keyboard and mouse events and supported

USB devices. The application is responsible for all of the interactions with the

window manager and the local operating system. The following diagram shows

how an application would integrate the core library and broker library into a

custom application.

PCoIP Core API

This method uses the PCoIP Core API to integrate the PCoIP protocol into a

custom application. This method is necessary if you want custom features in the

client beyond that which is possible using the Session Client API. 

PCoIP Core API

This diagram shows the architecture with a custom application integrating the

core library. 



*Partner Virtual Channel Plugins can be developed using the Virtual Channel

SDK, to enable this you can combine the PCoIP Client SDK with the PCoIP Virtual

Channel SDK.

PCoIP Core API and Application Functionality

Using the Core API the application developer has more control over the client

application than the PCoIP Session API but the developer must implement the

integration between the local OS and the core library.

Broker Interactions

The core library does not implement any of the broker protocol interactions. The

application is responsible for obtaining the PCoIP agent address, port number

and session tag, using the Broker Client API or some other brokering method,

and passing these to the core library.

Session Establishment

The application must provide the PCoIP agent address, port number and session

tag to the core library in order to establish a PCoIP session.

Display Topology

The application is responsible for deciding what displays to present to the user.

The application may specify up to four displays with resolutions up to

4096x4096. The application must determine the correct display position and the

rotations (if any).

Keyboard Events

The application is responsible for handling local keyboard events, and providing

the core library with scan codes to send to the remote host.



Mouse Events

The application must provide the mouse events, with either absolute or relative

coordinates, for the core library to send to the remote host.

Touch Events

If the application supports touch events, the core library can forward these to the

remote host.

Cursor Handling

Local cursor handling is critical for providing the most responsive user

experience possible. The application is responsible for updating the local cursor

shape and position on call-back from the core library.

USB Redirection

The application is responsible for determining if any USB devices should be

connected to the remote session. The core library will disconnect the USB

devices from the local system and redirect the device to the remote system.

Session Reconnection

The core library supports reconnecting a session (for up to 20 minutes) in the

event of a network disruption. The application is notified when a network

disruption occurs and provides a method for terminating reconnection attempts.

Session Termination

The core library provides a method for the application to terminate the session.



PCoIP Session Phases

There are two phases in a PCoIP session:

• Pre-session In the pre-session phase, a PCoIP client communicates with a

PCoIP broker to authenticate a user and obtain a list of desktops for which

that user is authorized. The client then presents this list to the user for

selection, and asks the broker to establish a PCoIP session with the selected

desktop.

• Session In the session phase, the PCoIP session has been successfully

launched and the client is connected to the remote desktop. Once the PCoIP

connection is established, a session client is invoked by the pre-session

client. The session client is primarily a conduit between the host and the

client applications. For a list of customizable in-session properties, with

examples, see Customizing the PCoIP Session.



About Brokered and Non-Brokered
Connections

PCoIP-compatible brokers are resource managers that authenticate users and

dynamically assign authorized host agents to PCoIP clients based on the identity

of the user. PCoIP clients can connect to PCoIP agents using a PCoIP-

compatible broker, called a brokered connection, or directly, called a non-brokered

or direct connection. The broker client library included in the Client SDK is

designed to communicate with PCoIP-compatible brokers using the PCoIP

Broker Protocol. In direct connections, when no broker is used, the PCoIP agent

acts as its own broker. The client makes the same calls to the broker client

library in either case.

Example pre-session Client

The included pre-session client, , uses the included broker client

library to execute transactions using the PCoIP Broker Protocol. This example client

demonstrates how to establish both brokered and non-brokered connections



broker_client_example.exe



Setting Up a PCoIP Agent Test
Environment

Before developing your custom client, you should set up a working PCoIP

system. Teradici recommends establishing a small proof-of-concept system for

custom client testing, consisting of a host machine with an installed PCoIP

agent.

To establish a working proof-of-concept test system:

1. Establish your host virtual machine and determine the PCoIP agent that best

fits your actual PCoIP environment.

2. Install the PCoIP agent on the host machine. For PCoIP agent installation

instructions, refer to the appropriate administrators' guide:

• PCoIP Standard Agent for Windows Guide

• PCoIP Graphics Agent for Windows Guide

• PCoIP Standard Agent for Linux Guide

• PCoIP Graphics Agent for Linux Guide

License Requirment

Before using your test environment, you must install a PCoIP agent development license on the

host machine. You received a license when you subscribed to a Teradici All Access solution,

specifically Cloud Access or Cloud Access Plus. If you do not have a license, obtain one from

Teradici before proceeding.



PCoIP System Architecture Reference

For details about proof-of-concept deployments, including supported PCoIP agents,

environments, and operating systems, see Teradici All Access Architecture Guide.



https://www.teradici.com/web-help/TER1608004/Default.htm
https://www.teradici.com/web-help/pcoip_agent/standard_agent/windows/19.08/admin-guide/installing/overview/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/19.08/admin-guide/installing/overview/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/linux/19.08/admin-guide/installing/installing/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/linux/19.08/admin-guide/installing/installing/


3. Install your agent license on the host machine. For license installation

instructions, see the Administrators' Guide for your host machines PCoIP

agent.

Connecting To Your PCoIP Agent

Once your test system is set up, you can establish PCoIP connections to it using

Teradici PCoIP Software Clients. For environment testing and troubleshooting

purposes, the Teradici PCoIP Software Client is available here:

• Teradici PCoIP Software Client for Windows

Establishing a PCoIP Connection Using a Teradici
PCoIP Software Client

To test your development environment, make a direct (unbrokered) connection to

your development host using a Teradici Software Client. If you are able to

connect using a Teradici software client, your host is correctly configured. The

following illustrations show examples of the pre-session phases using a Teradici

software client:

Pre-Session Connection

The user of the PCoIP Client request the PCoIP Agent by providing the FQDN of

the remote workstation where the PCoIP Agent has been installed. 

https://docs.teradici.com/find/subscription/cloud-access/product/cloud-access-software/2.15/component/software-client-for-windows/19.05


The user of the PCoIP client is then autenticated. If authentication is successful,

a PCoIP session will be launched. 



Connecting to a USB Device

Remote Windows hosts using the PCoIP Standard Agent or the PCoIP Graphics

Agent can use USB devices that are attached to the client. When you connect a

local USB device to your remote host it will be disabled on the client machine.

USB device connections do not persist across multiple PCoIP sessions. You

must connect your USB device each time you connect.

To connect to a USB device:

1. Attach the USB device you want to connect.

2. Select Connection > USB Devices from the PCoIP Software Client menu.

• A list of USB devices connected to your client machine appears.

Integrated USB devices, such as built-in cameras on laptops, will appear

in this list along with devices you have plugged in yourself.

• Some devices will identify themselves only as USB Device.

3. Click Connect beside the USB device you want to use.

PCoIP Agent needs to be configured to enable USB redirection

The USB menu will only show up if the PCoIP Agent has been configured to enable USB

redirection and a USB device has been detected by the PCoIP Client.



ePadLink Signature Pad and some Wacom tablets are connected via local termination

If you are using an ePadLink Signature Pad and certain Wacom tablets they can be connected

via local termination. You do not need to carry out any other steps to establish this connection.

For information on which Wacom tablets are locally terminated, see Wacom Tablets.





To disconnect a USB device:

1. Select Connection > USB Devices from the PCoIP Software Client menu.

Connecting to Human Interface Devices

Most Human Interface Devices (HIDs), such as keyboards and mice, are automatically handled

by the PCoIP Software Client and don't appear on in this list even if they use a USB connection.

If you need to connect a Human Interface Device that can't be locally processed, like a 3D

mouse or a Wacom tablet, enable the Show Human Interface Devices checkbox to reveal the

device in the USB device list and click its Connect button.

You may also have to complete additional configuration steps or install drivers on the host

machine.





2. Click Disconnect beside the USB device you want to disconnect. 



Disconnecting a Session

To disconnect a PCoIP session from either client, select the Connection >

Disconnect menu option.

Quitting the application will also disconnect the current session.

Session Reconnection

If a network interruption is detected, the PCoIP session enters a reconnecting

phase. In this phase the client will show you the network reconnecting dialog

which indicates that there is a network issue and that the client is trying to

reconnect and re-establish the PCoIP session. You can click disconnect to

cancel the attempted reconnect and disconnect the session completely. If the

reconnection is successful, the notification dialog will disappear and the session

will be restored. If it is not successfull, the session will be disconnected

completely.

Quickly disconnect from a session

To quickly disconnect from a session, press Ctrl + Alt + F12.





Changing the PCoIP Software Client
Window Mode

You can use the PCoIP Software Client in full-screen or windowed mode. Full-

screen mode is recommended in most cases.

Activating Full Screen Modes

The PCoIP Software Client provides two full-screen modes: one monitor and all

monitors.

To switch from windowed mode to full-screen mode:

• To use one full-screen display, select View > Show Fullscreen One Monitor.

All open windows and applications will be moved to a single full-screen display.

This is equivalent to disconnecting all but one monitor from a physical host.

• To use all available full-screen displays, select View > Show Fullscreen All

Monitors.

This mode shows full-screen displays on all client monitors.

To switch from Fullscreen One Monitor to Fullscreen All Monitors mode:

1. Reveal the menu bar by moving the mouse cursor to the top of a client

display.

2. Select View > Show Fullscreen All Monitors.

Keyboard shortcut

You can also enter full-screen mode by pressing Ctrl+Alt+Enter while in windowed mode. The

shortcut will activate whichever full-screen mode was used last, or all monitors if no previous

selection was made.





To switch from Fullscreen All Monitors to Fullscreen One Monitor mode:

1. Reveal the menu bar by moving the mouse cursor to the top of a client

display.

2. Select View > Show Fullscreen One Monitor.

Miminizing the PCoIP Software Client from a Full-
screen Mode

To minimize a software client in full-screen mode:

1. Reveal the menu bar by moving the mouse cursor to the top of any display.

2. Select View > Minimize Client.

Activating Windowed Mode

To switch from full-screen mode to windowed mode:

1. Reveal the menu bar by moving the mouse cursor to the top of any display.

2. Select View > Leave Fullscreen.

Persistent Display Topology

Depending on the display topology mode you have selected, for example Fullscreen One

Monitor, if you disconnect and then reconnect to the session, it will maintain that same mode

upon reconnection. The state and mode will be preserved.



Keyboard shortcut

You can also minimize the client by pressing Ctrl+Alt+m while in any full-screen mode.



Keyboard shortcut

You can also enter windowed mode by pressing Ctrl+Alt+Enter while in any full-screen mode.





Enhanced Audio and Video
Synchronization

Enhanced Audio and Video Synchronization (A/V Sync) provides improved full-

screen video playback, reducing the difference in delays between the audio and

video channels and smoothing frame playback on the client. This improves lip

sync and reduces video frame drops for movie playback.

This feature introduces a small lag in user interaction responsiveness when

enabled. Using enhanced audio and video synchronization will reduce the

maximum frame rate.

Enhanced A/V Sync is enabled on a per-display basis, so you can dedicate

individual displays to playback without impacting responsiveness on the others.

The enhanced A/V Sync feature is turned off by default and needs to be turned

on for the menu items to appear.

To turn on A/V Sync:

1. Go to C:\%appdata%\Teradici\Teradici PCoIP Client.ini and add the following

line: 

The above text is OS specific. Note the setting changed from 0 to 1.

When enabled, a check mark will appear beside the enhanced A/V Sync menu

item on that display. It is disabled on all displays by default.

To use enhanced A/V Sync:

1. If you are in full-screen mode, reveal the menu bar on the display you want to

enhance by moving the mouse cursor to the top of the screen.

2. On the display you want to enhance select View>Enhanced A/V Sync to

toggle the enhanced sync mode.

enable_enhanced_avsync=1



Persistent Display Topology

The Enhanced Audio and Video Synchronization feature is persistent across sessions from the

same client, provided that the display topology has not changed.





Sending a Ctrl-Alt-Del Command

To send the Ctrl-Alt-Del keyboard command to a remote workstation, select the 

Connection > Send CTRL-ALT-DEL menu option.



Changing the Language

In addition to English, the PCoIP Software Client also supports these languages:

Chinese (Simplified), French, German, Italian, Japanese, Korean, Portuguese

(Brazil), Portuguese (Europe), Russian, Spanish, and Turkish. During installation,

you can select one of the supported languages.

To change the language after installation:

In Control Panel > Region and Language > Formats tab, select another language

in the Format list.



PCoIP Ultra

The PCoIP Client provides support for PCoIP Ultra, the latest protocol

enhancements from Teradici. PCoIP Ultra is optimized for truly lossless support

with bit-exact color accuracy and preservation of content detail at the highest

frame rates.

PCoIP Ultra protocol enhancements propels our industry-recognized

performance into the future of remote computing, with faster, more interactive

experience for users of remote workstations working with high-resolution

content.

PCoIP Ultra is disabled by default. To enable it, see Enabling PCoIP Ultra.

PCoIP Ultra Enhancements

In version 19.05, PCoIP Ultra provides the following benefits:

• Support for 4K/UHD high frame rate content.

• Efficient scaling across multicore CPUs leveraging AVX2 instruction sets.

• Highest image quality, with efficient build-to-lossless and color accurate.

• Dynamic network adaption and network resilience.

The Software Client for Windows 19.05 with PCoIP Ultra contains certain

limitations around USB and printer plugin redirection. The latest beta version of

PCoIP Ultra is available via our Technology Preview version, as outlined below.

https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/19.08/admin-guide/features/pcoip/ultra/


Requirements

To take advantage of PCoIP Ultra, you need to meet these requirments:

• A PCoIP agent (any type) 19.05.0 or later.

• A PCoIP Software Client for macOS, PCoIP Software Client for Windows or

PCoIP Software Client for Linux, 19.05.0 or later.

• The CPUs on both the agent and the client machines must support the AVX2

instruction set.

PCoIP Ultra Technology Preview

PCoIP Ultra is an evolving technology, and new capabilities and enhancements are introduced

frequently.

If you would like to test unreleased versions of PCoIP Ultra, we invite you to join the PCoIP Ultra

Technology Preview program. Technology Preview users receive pre-release versions of Teradici

software for use in non-production environments, and provide feedback to our engineering

teams.

To learn more and to join the technology preview, visit the Teradici Support site.



PCoIP Software Client for Windows users

Support for PCoIP Ultra on the PCoIP Software Client for Windows is provided via the PCoIP

Ultra Technology Preview as described above.



https://help.teradici.com/s/technology-preview-program


Session Client Binary

The SDK is bundled with a session client binary, which can be invoked via

command line or programmatically from a pre-session client. The session client

for Windows is located in the SDK distribution on the following path:

• [working directory]\bin\client_session.exe

For an example of programmatically invoking the in-session client, search for 

 in [working directory]

\examples\broker_client_example\main.cpp. After the PCoIP connection is

established, several command line options are available from the in-session

client, as outlined above.

launch_session



Customizable Session Features

The following PCoIP session features can be customized:

• Session Menu bar Visibility

• Disable Hot Keys

• Windowed or Fullscreen Mode

• Set Host Resolution

• Custom Client Branding

• Image Scaling

• Maintain Aspect Ratio

• USB Auto Forward

• USB VID/PID Auto Forward

• Disable USB

• Locale

• Session Log ID

• Log Level

• Log File Name

• Force Native Resolution

Disable Session Menu Bar Visibility

To enhance the user experience the PCoIP Session Client enables the menu bar

by default, however some use cases may require that it be disabled, or hidden, in

Examples show command-line usage

The examples shown here invoke the session client via the command line. You can also set

these properties when invoking the session client programmatically.





order to prevent the user from accessing menu functionality. To disable the

menu bar feature use the parameter .

Disable Hot Keys

To improve usability, session hot keys, such as Ctrl+Delete+F12 (which

disconnects a PCoIP session) are available to users by default. The parameter

for this feature is .

Windowed or Fullscreen Mode

Depending on your application needs, you can display the PCoIP session in

either windowed or fullscreen mode. Fullscreen mode allows the display

topology to support multiple monitors as an extended desktop; windowed mode

gives you the flexibility to display multiple application windows in parallel and

switch between them quickly. Windowed mode improves the user experience, as

well as resulting in an increase in performance. Windowed mode is the default

mode, and to activate fullscreen mode use the  parameter.

Set Host Resolution

Normally, the session client opens with arbitrary window dimensions. In some

cases, you may wish to lock the resolution of your host application displays. This

ensures the user’s viewing experience is consistent across different monitors

and their native resolutions. The parameter for this feature is 

.

• Host Resolution Limitations: It is only possible to specify one target

resolution for all displays. The host resolution will not perform to its optimal

capability if you have monitors with different resolutions.

disable-menubar

disable-hotkeys

full-screen

set-host-

resolution



Custom Client Branding

You can customize the branding of your custom session client in several ways by

creating a client branding package. These customizations affect the user’s

experience once they have connected to their PCoIP session. The parameters for

this feature are  and . The following elements

can be customized in the session client:

• The OS application title and logo

• The session client toolbar title and logo

• The logo displayed in the OS taskbar

• The following default menu item label:

• About PCoIP Client

• Quit PCoIP Client

• The content shown in the About dialog:

• Replace the dialog text

• Provide hyperlinks to corporate resources and product information

• Add a custom logo

• Customize a client alert and message window titles.

Image Scaling

The image scaling feature enables scaling on the client without having to specify

the desktop resolution. You can apply image scaling when the resolution of the

client monitor is not the same as the resolution provided by the host. This

feature provides a smoother process for image scaling on the client. The

parameter for this feature is .

Maintain Aspect Ratio

If the host and client aspect ratios do not match, and this parameter is not used

then the display will be stretched to fit. The parameter for this feature is 

branding-package branding-hash

enable-scaling



. If the native aspect ratios of the host’s display and the

client’s display do not match, the host’s aspect ratio will be preserved and will

appear in the client with black bars either on the sides or top and bottom of the

display.

USB Auto-Forward

Automatic bridging enables you to auto bridge all non-HID USB devices. Use the 

 parameter.

USB Vendor ID/Product ID Auto-Forward

You can automatically forward up to 20 USB devices to the host at the start of

the session by calling the session client executable with 

and the required VID/PID pairs. Devices that are auto-forwarded will appear in

the USB Devices dialog box, enabling users to connect or disconnect them from

the host. The following rules apply to VID and PID values:

• VID/PID values are comma-separated: ,

• VID/PID pairs are space-separated:  

• VID/PID pairs with invalid values will be discarded. Discarded rules appear in

the event log.

• Up to 20 devices will be passed; if more than 20 are attempted, the first 20

will be accepted and rest ignored. Ignored rules appear in the event log.

Disable USB

You can disable USB functionality in the client with the  parameter.

Locale

The Local feature enables you to use the appropriate localized user interface for

the client session. This feature will make the session GUI more flexible to

maintain-aspect-ratio

usb-auto-forward

vidpid-auto-forward

xxx yyy

aaa, bbb ccc,ddd

disable-usb



accomodate a wide range of languages. You can choose the language

translation you require by setting the  parameter. The following table

states the available language translations and codes:

 

Session Log-ID

 is a UUID that uniquely indentifies the session in all PCoIP log files.

locale

Locale Code Language

de German

es Spanish

fr French

it Italian

ja Japanese

ko Korean

pt Portuguese (EU)

pt_BR Portuguese (Brazil)

ru Russian

tr Turkish

zh_CN Chinese (Simplified)

zh_TW Chinese (Traditional)

Default Language

By default, the language is set to English.



log-id



Log Level

 is the log level parameter. It is possible to over-ride the default log-

level, which is 2, by specifying a different log-level parameter. All messages at

the specified level or lower will be logged.The following parameters apply:

• 0 = Critical

• 1 = Error

• 2 = Info

• 3 = Debug

Log File Name

The default location of the log file may be overridden using the 

parameter to specify a full path and file name for the log-file.

Force Native Resolution

The resolution of the client monitor can be set to the native resolution when the

session client is launched using the 

parameter

log-level

Troubleshooting and Support

When reproducing issues for the purposes of troubleshooting and support, set the log level to 

Debug.This will enable you to capture a log of all information messages and errors.



logfile

Custom Location

If a custom location is used for the log file then the support bundler script should be updated to

capture the logs from that location.



force-native-monitor-resolution



Branding Your Session Client

You can customize the branding of your custom session client in several ways by

creating a client branding package. These customizations affect the user’s

experience once they have connected to their PCoIP session. The following

elements can be customized in the session client:

• The OS application title and logo

• The session client toolbar title and logo

• The logo displayed in the OS task bar

• The following default menu item labels:

• About PCoIP Client

• Quit PCoIP Client_ (Windows only)

• The content shown in the About dialog:

• Replace the dialog text

• Provide hyperlinks to corporate resources and product information

• Add a custom logo

• Customize client alert and message window titles.



Limits on Customization

You may not be able to programmatically modify certain session features due to

limitations imposed by the operating systems's user interface.

Windows Limitations

The application process name in Windows Task Manager cannot be altered at

run time. The process name will be PCoIP Client.

Bypassing run-time Configuration Limitations

The limitations described here are enforced at run time. It is possible to bypass these

restrictions by editing the application executable. Modifying this file will invalidate the Teradici

signature.





Creating a Branding Text Layout File

The layout file format used to customize the session client is an UTF-8 XML text

file. The layout schema is a top-level  element with a

version attribute describing the schema version, and containing the required

elements described next:

The available elements are outlined in the following table:

<pcoip-client-branding/>

<pcoip-client-branding version="1.0">
...
</pcoip-client-branding>



 

A full text layout file looks like this:

Parent

Element

Child

Element

Description

Required! The name of your custom session client. This will be

used as the application window file.

Required! The file name of your application icon. In Windows,

this appears in the Windows toolbar and the window header.

Required! Describes the text labels used in OS toolbar menu's.

The text label for the About... menu item. Optional. Without this

field, there will not be an About menu item.

The text label for the Quit... menu item. Optional. Without this

field, you will not have a Quit menu item.

Required! Describes the contents of the About... dialog. Must

have the following required attributes: title (string): The dialog

text and minWidth (number): The minimum pixel width of the

dialog. For example: 

Describes a line of text in the dialog. All lines are optional, but

the About window will be empty unless you provide at least

one.  accepts the following attributes: align (string

keyword): The text alignment; for example, "center". This

alignment applies to all child elements of the line. Lines can be

self-closed to create a blank line ().  can contain the

following elements:  contains a filename for a logo or

other graphic element: . 

 contains the display text for each line: 

. 

takes a url parameter and creates a working hyperlink: 

.

<app-

name>

<app-

icon>

<toolbar-

menu>

<about-

item>

<quit-

item>

<about>

<about title="My Custom Client" 

minWidth="100">

<line>

<line>

<line>

<logo>

<logo>about_logo.png</logo>

<text> <text>This 

text is displayed on the line. </text> <hyperlink>

<hyperlink url="www.teradici.com">Teradici</hyperlink>



<?xml version="1.0" encoding="UTF-8"?>
<pcoip-client-branding version="1.0">
<app-name>My Custom Client</app-name>
<app-icon>app_icon.png</app-icon>
<toolbar-menu>
<about-item>About My Custom Client</about-item>
<quit-item>Quit My Custom Client</quit-item>
</toolbar-menu>
<about title="About My Custom PCoIP Client" minWidth="0">
<line align="center"><logo>about_logo.jpg</logo></line>
<line />
<line align="center"><text>My PCoIP Client</text></line>
<line align="center"><text>Version 0.0.0</text></line>
<line align="center"><text>© Copyright 2016 My
Corporation</text></line>
<line align="center">
<hyperlink url="www.my-company.com">My company</hyperlink>
</line>
<line />
<line align="center">
<text>For help, click here: </text>
<hyperlink url="www.google.com">Google</hyperlink>
</line>
</about>
</pcoip-client-branding>



Creating a Branding Package

In order to customize your session client, you must create a client branding

package using the Teradici Custom Branding Package Utility. The Teradici

Custom Branding Package Utility is located in the following location:

• Windows Clients: 

To create a custom branding package:

1. Create a product icon (png, 128px x 128px).

2. Create a company logo (png, any size).

3. Create a text layout file describing the customized UI element strings and

dialog content.

4. Create the branding package using .

The system will respond with the output file and hash:

5. Note both the output file name and the hash value. These will be passed to 

.

bin\TeradiciBrandingPackageUtility.exe

TeradiciBrandingPackageUtility

TeradiciBrandingPackageUtility.exe -x my_custom_branding.txt -o
my_custom_branding.bp -i my_custom_icon.png

Output file: my_custom_branding.bp
Hash:
cbc3fd3c6d001a1e1f06342bcccf2a62bd748c3cf1dd2e4c9c29561ea07bd089

client_session



Using the Branding Package

Once you have created the branding package, it can be used by the session

client. The pre-session client is responsible for verifying the package and

passing it to the session client executable.

To use the branding package:

1. Verify the branding package signature.

2. Call the session client executable and pass the branding package name and

hash, noted when creating the branding package, using the parameters 

 and .

For example (one command):

-

branding-package -branding-hash

client_session -branding-package my_custom_branding.bp
-branding-hash
cbc3fd3c6d001a1e1f06342bcccf2a62bd748c3cf1dd2e4c9c29561ea07bd089
<other-params>



Supporting USB Devices

Transferring non-HID USB devices from the client to the host is called bridging.

Both the PCoIP agent on the host machine and the PCoIP client must enable

bridging before devices can be transferred. By default, Windows PCoIP agents

allow bridging of all USB devices. Administrators can globally disable USB

bridging support, or enforce device whitelists or blacklists, using GPO variables

on the host machine. Clients cannot bridge devices that are disallowed by the

agent.

There are two methods of providing USB support from your PCoIP client:

• Automatic: Automatically bridged devices are passed from the pre-session

client to the session client executable, which forwards them to the host

agent. No user interaction is required.

• Manual: Manually bridged devices are selected by the user, during a PCoIP

session, from the session client UI.

Controlling USB support on Windows PCoIP Agents

For information about USB bridging configuration on Windows PCoIP agents, see one of the

following guides: - Teradici PCoIP Graphics Agent 2.15 for Windows Administrators' Guide - 

Teradici PCoIP Standard Agent 2.15 for Windows Administrators' Guide



USB support on Linux PCoIP Agents

Linux PCoIP agents do not support non-HID USB devices. Only HID devices such as keyboards

and mice can be used with Linux PCoIP agents.



Windows Clients Require an Additional Package

To enable USB support on Windows clients, you must install the Client USB package



https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/2.15.0/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/windows/2.15.0/


Manually Bridging USB Devices

If you need to support more than 20 USB devices, or if you expect your users to

control which devices can be bridged, they can be manually added by opening

the client’s USB Devices menu and enabling them.



Updating the Client USB Package

The Client USB package must be uninstalled before installing a new version.

To update the Client USB Package:

1. Open a command line window.

2. Navigate to the directory where the Client USB package was originally

installed.

3. Run the uninstaller located in the _USB_ directory.

4. Follow the directions in Installing the Client USB Package for Windows.

Rebooting is not Necessary

The installer will recommend rebooting after uninstalling. This is only necessary if you will not

be reinstalling, and wish to completely remove the driver from your system. If you will be

reinstalling the Client USB package, rebooting is not necessary.





Exit Codes for Programmatic USB
Installations and Uninstallations

You can make the installer and uninstaller calls programmatically from your

client application. The return and exit codes you should expect are summarized

in the following tables:

 

 

Installer Return/Exit Codes

0: Success, no reboot required. Expected on a fresh installation.

1: Success, reboot required. Unexpected, but harmless.

2: Success, installation continues after reboot. Expected when running the installer during an

upgrade without rebooting (installing a new version after uninstalling an old version, with no

reboot in between). This indicates that while the driver is usable immediately, additional action

has been scheduled following the next reboot. This prevents scheduled actions by the

uninstaller from disabling the driver.

-1: Error, general. An unexpected error occured. The most likely cause is insufficient privileges

to install drivers, or another permissions issue.

Uninstaller Return/Exit Codes

0: -

1: Success. Expected

2: -

-1: Error, general. An unexpected error occured. The most likely cause is insufficient privileges

to ininstall drivers, or another permissions issue



Installing the Client USB Package for
Windows

USB support in Windows applications is provided by the Client USB package. The

Client USB package installs a filter driver that attaches to USB hub driver

instances. This filter driver enables the PCoIP client software to take ownership

of USB devices, so they can be forwarded to the host. The Client USB package

must be installed if you want to integrate USB features into your client.

To install the Client USB package:

1. Open a command line window.

2. Enter the following command (all as one line):

Where:

•  is the location where the SDK was unpacked.

•  suppresses the recommendation to reboot after install.

•  automatically closes the installer after installation.

•  specifies the base path for installation.

[working directory]\bin\PCoIP_Client_USB_
installer.exe /noreboot /autoclose /D={path}

{working_directory}

/noreboot

/autoclose

/D={path}

An Uninstaller is automatically created

An uninstaller will be placed at .



{path}\USB\

Silent Mode

To install or uninstall without pop-up messages, use the  parameter when running the

installer.



\S



For example, this command will install the USB package under C:\Program 

Files (x86)\Teradici\PCoIP Client\:

[working directory]\bin\PCoIP_Client_USB_installer.exe
/noreboot /autoclose /D="C:\Program Files (x86)\Teradici\PCoIP 
Client"



Configuring Wacom Tablets

This section outlines how to configure your Wacom tablet through the PCoIP

Client session. There are two available features within the PCoIP Client that can

be used to configure the monitor display and orientation. This only applies to

locally terminated Wacom Tablets.

Tablet Monitor

The Tablet Monitor feature enables you to select the monitor you want to use

with your Wacom tablet. You can change between using a pen or mouse and

select the orientation position.

To configure Tablet Monitor settings:

1. Select View from the in-session options bar.

2. Check the Tablet Monitor option.

3. Open Wacom Tablet Properties from the Wacom Desktop Center.

4. Select your device, tool and application.

5. Select your screen area from the dropdown menu.



Tablet Orientation Left-handed

The left-handed orientation configures the tablet for a left-handed orientation.

Select ExpressKeys Right for a left-handed orientation, and ExpressKeys Left for

a right-handed orientation. Rotate the tablet to the desired orientation.

To configure Tablet Orientation:

1. Select View from the in-session options bar.

2. Check the Tablet Orientation Left-handed option.



3. Open Wacom Tablet Properties from the Wacom Desktop Center.

4. Select your device, tool and application.

5. Select your orientation from the dropdown menu.



PCoIP Support Bundler Tool

Teradici may request a support file from your system to help troubleshoot and

diagnose PCoIP issues.

To create a support file:

1. Open a PowerShell command prompt.

2. Set the PowerShell execution policy to allow the script to run: 

3. Launch the support bundler:

The file will be created and placed in the $env:ProgramData\Teradici\Support\

directory.

Set-ExecutionPolicy -Scope Process -ExecutionPolicy Bypass

path-to-unzipped-sdk-package"/sdk/examples/support-bundler/pcoip-
client-support-bundler.ps1



Minimal Client Example

The following is an example of how to use the Teradici broker libraries and the

PCoIP Session libraries to connect to an agent and launch a PCoIP session.

The following steps outline how to build this example:

1. Install the SDK.

2. Create a build/directory inside minimal_client/

3. From build/, run cmake configure and build commands.

4. Update the login_info.txt with the address and credentials of an authentic

agent so that the built client can talk to the agent.

5. Run the built minimal_client application. It should be able to launch a

brokered PCoIP Session to the agent.



Using the Broker Client Example

The SDK provides a sample command line pre-session client called broker client

example. This would enable you to call the included broker client libraries and

establish a PCoIP connection. The broker client example demonstrates the

success path for establishing new PCoIP sessions.

The sample broker client is located here:  There are several files in this

directory, but only two are relevant for the broker client example:

•

•

The  executable is the sample command-line client; the 

 text file contains authentication information used by the client.

Do not use the Broker Client Example in Production

The broker client is provided as an example only, and should not be used in production. The

client does not have thorough error handling and does not validate or sanitize user input.



bin/

broker_client_example.exe

login_info.txt

broker_client_example

login_info

About 

The broker client example uses a small local text file to supply session input values. The

following is a sample  file (one line):

In this example:

• The FQDN of the host server is 

• The Domain is 

• The User is 

• The Password is 

• The Host name is 

 login_info.txt

login_info.txt

sal-w2k8-ch605.autolab.local autolab autorunner "mypassword" sal-w2k8-ch605

sal-w2k8-ch605.autolab.local

autolab

autorunner

mypassword

sal-w2k8-ch605



Remote sessions established by  are exactly the

same as sessions established using the PCoIP software client, except that the

input values are provided by  instead of the client’s user

interface.

broker_client_example.exe

login_info.txt



Initiate Broker Connection Flow

To initiate the broker connection with the broker client example, set up your 

 file and then call  using 

 as an argument.

To initiate the broker connection using the broker client example:

1. Open  in a text editor.

2. Add the following information, in this order, separated by spaces:

• The FQDN of the host server

• The server domain

• The User name

• The User password

• The Host name

3. Save the text file.

4. Open a Windows command line tool and type:

The broker client example will display a status message similar to the one

shown below:

login_info.txt broker_client_example.exe

login_info.txt

login_info.txt

# broker_client_example.exe login_info.txt



Connected Successfully.
Desktop ID : sal-w7p64-sa15.autolab.local
ip_addr : 10.64.60.147
port : 4172
connect_tag:
SCS1fw0Zbk+Eu7q2iz0/M7mxfEE52au/3Jedtgp16L/rA8iB00+Er+YJd0yIL0xd9M
v5V0CDLSDmUNkOCwyyV1+u3w1aA7hXxEWmzhAA
session_id : 2305843009213693954
sni : SAL-W7P64-SA15
URI: "teradici-pcoip://10.64.60.147:4172?sessionid=
2305843009213693954&sni=SAL-W7P64-SA15", PARAMETERS: "connect-
tag=SCS1fw0Zbk%2bEu7q2iz0%2fM7mxfEE52au%2f3Jedtgp16L%2frA8iB00%2bE
r%2bYJd0yIL0xd9Mv5V0CDLSDmUNkOCwyyV1%2bu3w1aA7hXxEWmzhAA"



Launching the Session Client from Broker
Client Example

Use the  switch (lowercase L, for launch) to have the broker client example

invoke the session client. This enables you to send invoke the session client

without worrying about the 60-second connect tag window.

To establish a new PCoIP connection using the  switch:

1. Open a command prompt and change directory to 

2. Run the command line client, providing the  file as an

argument:

l

l

bin

login_info.txt

broker_client_example login_info.txt



Passing Customization Parameters to the
Session Client

When using the  parameter to automatically pass session information to the

session client, you can pass additional session client parameters by enclosing

them in double quotes. This enables you to demonstrate session client

functionality without racing to build a command line string within the session

client’s 60-second window. For example, to invoke the session client with the

menu bar disabled, type:

l

broker_client_example login_info.txt l "disable-menubar"



The Broker Client Example

The included sample broker client demonstrates how the APIs can be used to

customize and control the pre-session and session phases of the connection.

Code is an API Demonstration Only

The sample session client, described in the following sections, demonstrates a simple

connection scenario using the supplied . The example unrealistically

assumes that all requests and calls succeed as expected, and performs only basic error

handling. An actual client implementation is likely to be far more complex; for example, you will

need to handle failed broker certificate verification, account for other authentication steps

beyond a simple user ID and password combination, and any other circumstances dictated by

your system requirements.



broker_client_library



The Broker Client Example Sequence

This section describes how the broker client example implements the PCoIP

session sequence. It also provides an overview of invoking and using the

executable session client.

Custom Broker Client Library Implementations

PCoIP clients interact with PCoIP-compatible brokers and PCoIP agents using an abstraction

layer called a broker client library. The following example uses the supplied broker client library.

You may, however, choose to write your own broker client library to meet specific requirements,

or use a thirdparty broker library which does not use the PCoIP Broker Protocol. Refer to the 

PCoIP® Connection Broker Protocol Specification for details on how to design and implement

your own connection broker.



https://docs.teradici.com/find/product/cloud-access-software/2019.05/pcoip-broker-protocol/2.12.0?subscriptionName=cloud-access-plus


PCoIP Session-Creation Steps and Actors

The steps indicated below are used and documented in the bundled sample

code. Refer to the code for specific function calls, expected return values and

error-handling requirements. The example C++ code can be found in the SDK

package located here:

Direct (non-brokered) connections

When there is no PCoIP broker in a system, as in direct connections, the PCoIP agent acts as its

own broker. Clients make the same calls to the Broker Client Library whether there is a PCoIP

broker inline or not.





PCoIP Session Sequence used by the Sample Client 

Each of these steps is used in the sample code, with a comment identifying the

step number.



1. Set a logging function The  requires users to

provide a log function as part of the logging mechanism. A log function

template is provided in the example code.

2. Create a broker handle Create a handle for the broker instance.

3. Set client information This information identifies your client to the broker. It

should include the client name, client version, and client platform.

4. Set broker address and behavior on unverified certification This step

identifies the address of the broker you want to connect to, and specifies

error handling in the event the broker identity cannot be verified.

Alternatively, this could also be an Amazon Workspaces registration code.

5. Authentication between the broker and the client This step requests an

authentication method from the broker, and then submits the user’s

authentication information to the broker using the supplied authentication

method. The client must implement all the authentication methods required

by the broker.

6. Request desktop list Once the client is successfully authenticated by the

broker, request a list of host servers (desktops) that the authenticated user

is allowed to access.

7. Retrieve desktop info Loop through each desktop in the list acquired in step

6, requesting the name and ID of each desktop.

8. Process the desktop list Perform any processing required on the desktop

list, and provide it to the user interface for selection.

Custom Log Implementations

You can design and implement your own logging functionality, as long as it follows the same

callback signature of the log function template that is required by the PCoIP Client SDK API.



broker_client_library

Desktop Selection Presentation Customization

At this stage, you can also customize the dialogue and interface the user will use to select

a desktop.





9. Connect to selected host server This step asks the broker to set up the

PCoIP session. The broker then contacts the agent, which supplies the

necessary information (most notably the session tag) the client will need to

establish the connection later. The PCoIP session is not established yet at

this stage.

10. Clear session with broker On a successful connection, clear the broker

session. This effectively disconnects the client from the broker.

11. Get desktop connection information and launch the session Request the

connection and security properties from the desktop (for example, its IP

address, its port number, or a session ID), and handle errors if any of the

required properties are not returned.

12. Proceed with established session This step invokes , and

implements the actual PCoIP connection. For specific instructions regarding

establishing PCoIP connections, see How to Establish a PCoIP Session.

13. Free desktop connection information When the in-session client has been

invoked, dispose of the collected desktop information.

14. Destroy the broker client handle Destroy the broker handle.

client_session



How to Establish a PCoIP Session

Before you can establish a PCoIP session with a host desktop, gather the

following host desktop details:

• IP Address

• Port number

• Session ID

• Server name indication (SNI)

• Connection tag

This information can then be passed to the provided in-session client to

establish a PCoIP session programmatically. See the example code for specific

call syntax. In terms of programming interface, there are two ways that the

connection and security information can be presented to :

Pass the pieces of Information Individually to the Executable The following

command invokes  to establish a PCoIP session and

passes the connection and session information as parameters, where:

• Connection tag: 

• IP address: 

• Session ID: 

- Encode all information into a string container (URI) and then pass to the

executable The following command invokes  to

establish a PCoIP session and passes the connection tag as a parameter

and a URI encapsulating the IP address and Session ID in a string container,

where:

client_session.exe

client_session.exe

SCS1WsopFJ3iz1l48PTJMXFkcD4b6M9aiakHXH3ellLhUROBceWAifSSn%2b4AV1FC8IihWVmsISmYFKeA25A

10.64.60.115

2305843009213693961

client_session.exe -i connect-tag=
SCS1WsopFJ3iz1l48PTJMXFkcD4b6M9aiakHXH3ellLhUROBceWAifSSn%2b4AV1FC
8IihWVmsISmYFKeA25AtzFrdMpdaCtqlic0zfxAA address=10.64.60.115
session-id=2305843009213693961

client_session.exe



• Connection Tag: 

• URI: "teradici-pcoip://10.64.60.115:4172?sessionid= 230584300921369396"

SCS1WsopFJ3iz1l48PTJMXFkcD4b6M9aiakHXH3ellLhUROBceWAifSSn%2b4AV1FC8IihWVmsISmYFKeA25A

URI Format Documentation

There is a document describing the URI format in the root of the SDK,



client_session.exe connect-tag=
SCS1WsopFJ3iz1l48PTJMXFkcD4b6M9aiakHXH3ellLhUROBceWAifSSn%2b4A
V1FC8IihWVmsISmYFKeA25AtzFrdMpdaCtqlic0zfxAA "teradicipcoip://
10.64.60.115:4172?session-id=230584300921369396"



Using the Client Session API

Use of the Client Session C++ API is demonstrated in 

. It includes the steps outlined in the diagram below:

 

PCoIP Session Client API Sequence Diagram

Each of these steps is used by the Session Client API, with a comment

identifying the step number:

1. Setup Environment and Implementations: Os specifc initialization.

Instantiate a Configuration Provider object.

2. Parse Command Line: Define and parse supported command line

parameters.

3. Setup Session Options: Validate the options passed via the command line

and setup the Configuration Provider object accordingly.

4. Setup Session Connection Information: Pack the session parameter,

received via the command line, into the structures required by the API.

<pcoip_client_sdk_session/modules/client_session/src/

client_session_main.cpp>



5. Get Session Instance and Run:: Obtain the main session object, set the

Configuration Provider and run the session. The run call blocks until the

session is terminated.

6. Post-Session Clean-up: Performs any post-session shutdown processing.



Setting Up the Development Environment

Once you have successfully established a session between a PCoIP Software

Client and a PCoIP host, you can start developing your own PCoIP client. To

begin, set up your client development environment, as discussed next.

To set up your client development environment:

1. Install Boost version 1.66 and OpenSSL 1.0.2n on the system. The CMake

modules provided with the SDK will automatically find them at CMake

configure time once they are installed.

1. Unzip the SDK tar file.

2. Copy the files to the desired directory where you are developing the custom

application. For information on building the SDK, see Building the SDK for

Windows.

Library Names and Versions

Library names and specific versions are encoded in the path names within the third-party tree.



OpenSSL version

 only contains the version of OpenSSL available at the

time of distribution. You need to obtain and update any future security updates that may be

issued.



session_client_third_party*.tar.gz

USB funtionality in Windows Client Applications

If you will be incorporating USB devices into your Windows client application, you must also

install the Client USB package. For instructions, see Supporting USB Devices.





Updating SDK Components

Updating the SDK to a new version can be done by replacing the old binaries with

new versions in place. There is no special upgrade path. Upgrading components

will not break compatibility with existing APIs.



Windows Prerequisites

The following must be installed to build the PCoIP Client SDK on Windows:

• Boost v1.66 and OpenSSL 1.0.2.14

• MS Visual Studio 2015 with Update 3 https://www.visualstudio.com/

downloads/

• CMake 3.4.1 https://cmake.org/download/ Make sure CMake is in the

system PATH; CMake does not automatically add itself to the system PATH

during installation.

CMake Version Requirement

The PCoIP Client SDK does not support versions of CMake higher than 3.4.3.



https://www.visualstudio.com/downloads/
https://www.visualstudio.com/downloads/
https://cmake.org/download/


Configuring CMake for PDB Files

In addition to the full .pdb files, a project can be configured to generate stripped

 files by adding the  linker switch. For example, in

CMake:

All full  files are copied over automatically to 

 if  is defined in

the cmake file. Stripped  files are generated at the location where the

 file is located.

.pdb /PDBSTRIPPED:filename

* set_target_properties( pcoip_client PROPERTIES LINK_FLAGS "/DEBUG
/PDBSTRIPPED:pcoip_client.pdb" )

.pdb

CMAKE_PDB_OUTPUT_DIRECTORY CMAKE_PDB_OUTPUT_DIRECTORY

.pdb

.vcxproj

Microsoft Documentation

For more information on debugging with symbols, see https://msdn.microsoft.com/en-us/

library/windows/desktop/ee416588(v=vs.85).aspx



https://msdn.microsoft.com/en-us/library/windows/desktop/ee416588(v=vs.85).aspx
https://msdn.microsoft.com/en-us/library/windows/desktop/ee416588(v=vs.85).aspx


Windows Build Procedure

1. From the Windows Control Panel, set an environment variable called 

 pointing to the third party libraries.

a. Open System in Control Panel.

b. Click on Advanced system settings.

c. On the Advanced ta, click Environment Variables.

d. In the lower box labeled System Variables, click New.

e. In the Variable Name field, type .

f. In the Variable Value field, enter the full path to root of the third-party

libraries.

g. Click OK on each of the three open dialogs.

2. Unzip the SDK tar file. Copy the files to the desired directory where you are

developing the custom application.

3. The CMake modules for finding the libraries within the package are located

inside . The required libraries are namespaced

by PCoIPSoftClientSDK.

4. In order to use the core APIs, use the following commands on your

application's CMake file for linking your application to the libraries that are

needed from the SDK:

LOCAL_THIRD_PARTY

Windows 7 Procedure

This procedure is correct for Windows 7. Other versions of Windows may use slightly

different methods to define environment variables.



LOCAL_THIRD_PARTY

"path-to-sdk-root"/cmake

list(APPEND CMAKE_PREFIX_PATH "path-to-sdk-root/cmake")

find_package(PCoIPSoftClientSDK REQUIRED)



5. At this point, you can link your application to the core library using the CMake

command:

6. You can link any other required libraries similarly by appending it to the above

command.

Packaging

All files needed to run the client, except the Microsoft Visual Studio 2015

redistributable, are contained in the 

directory.

target_link_libraries(your_application PRIVATE 
PCoIPSoftClientSDK:pcoip_core)

product\WINDOWS\x86\[Debug|Release]



The Application Dump File

If a crash happens within , an application

generates a dump file with the .dmp extension. Client application .dmp files are

saved in the folder where all log files are stored. The path to the log files is 

 for the session client. The .dmp

file can also be saved manually during a debugging process in Visual Studio.

When the Visual Studio debugger stops at an exception, close the pop-up

window, choose Save Dump As under the DEBUG tab, and save the dump file.

broker_client_example.exe

%LocalAppData%\Teradici\PCoIPClient\logs

Debugging Crashes in client_session.exe

The SDK does not include files for debugging  crashes. If a crash happens

in , the  file should be sent to Teradici for analysis



ClientSession.app

ClientSession.app .dmp



Files Required for Debugging

The following are a list of files required to debug a crash:

• .exe files

• .dll files

• .pdb files

• .dmp file

• source files

The PCoIP Client SDK contains the  files and the  files. The  file

that caused the crash should also be in the same directory as the  files.

You must use the  files that were generated when the  and  files

were built.

.dll .pdb .exe

.dll

.pdb .exe .dll



Debugging a Crash

The following steps outline how to debug a crash in 

:

1. Open Visual Studio 2015.

2. Select File>Open>File.

3. From the file selection diaglog, browse to the  file and open it.

4. Locate the Actions box at the top-right corner of the summary and click 

Debug with Native Only to start debugging.

5. If Visual Studio cannot find the path to the source file, it will present an alert

dialog and enable you to manually specify the path. If this occurs, provide

the actual path to the source files. If you do not have the files, click Cancel to

proceed without them.

6. Locate the location of the crash under the Call Stack tab in the Visual Studio

debugging window.

broker_client_example.exe

.dmp

Setting the Symbol Path

If the  files are not found, the path should be specified in the 

environment variable, or, locate the Actions box and choose Set symbol paths at the top-

right corner of the summary pagem and configure the path there.



.pdb _NT_SYMBOL_PATH



Frequently Asked Questions

The following are answers to commonly asked questions when contemplating

how to develop custom PCoIP Clients using the Teradici PCoIP Client SDK.

Q: Can I brand the pre-session client with my company logo and colors? A: Yes.

Your Teradici Cloud Access Platform agreement will contain detailed information

about corporate logos. Follow the Teradici branding guide for including the

PCoIP trademark in your final design.

Q: Are there guidelines for using the Teradici and PCoIP Brand? A: Yes. Refer to 

http://www.teradici.com/docs/brand-guide for details.

Q: Does the SDK support localization? A: Yes. In pre-session you have complete

flexibility to create clients that incorporate customizations. In-session, you can

use the  parameter to pass a locale to .

Q: Does my client need Teradici licenses to operate? A: The client itself does not

need a license to operate, but the PCoIP agents that it connects to do require

licenses. License handling is performed by the PCoIP Broker or PCoIP agent,

depending on the connection type. It is not handled by the client.

Q: How can I add additional functionality to my PCoIP Client? A: If you have

requirements that go beyond the default capabilities of the Client SDK, you can

integrate the PCoIP Virtual Channel SDK. The Virtual Channel SDK gives you the

ability to create custom PCoIP Virtual Channel plugins which stream data

between clients and hosts.

Q: Will my client work with all PCoIP agents? A: Yes. The PCoIP protocol works

with Cloud Access and Cloud Access Plus.

Q: What support options are available for the Client SDK? A: Teradici offers

Developer Support and Professional Services options for SDKs and APIs. Please

contact your Teradici account manager for details.

locale ClientSession

http://www.teradici.com/docs/brand-guide


Q: Does the SDK provide API for using managed installation systems like MSI? 

A: The SDK does not provide an API for managed installation. You are free to

choose your own installation method, including MSI.
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